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Adobe Photoshop CS for Photographers
This PDF on Color Management is an extract from Martin
Evening’s forthcoming book: Adobe Photoshop CS for
Photographers, which will go on sale from early 2004.
This latest update in the Adobe Photoshop for
Photographers series will contain 576 pages in full color.
The book has been completely redesigned and contains
information and updated advice on everything you need to
know about using Photoshop, from digital capture to print
output, as well as all that is new in Adobe Photoshop CS!

PDF usage
This PDF extract is only made available for delegates who
attend my seminars. It is password protected, is availableto
view only and print disabled. The copyright in the writing
and images remains the property of Martin Evening and the
contents may not be modified in any way, or used
commercially without permission from the author.

PDF structure
This PDF contains two chapter extracts from my
forthcoming book. The first part concerns image
management from capture to storage on the computer. And
the second section is all about making inkjet prints.

Website
There is a website for the book which will updated in due
course with further information about the book:

www.photoshopforphotographers.com

To order the book
Adobe Photoshop CS for Photographers is
published by Focal Press, an imprint of
Harcourt Education.

ISBN: 0 240 51942 6.
The title will be stocked in most major

bookstores throughout the UK and US and
via many resellers worldwide. It will also
be available for purchase from:
www.focalpress.com and also through the
on-line bookstores: www.amazon.com and
www.amazon.co.uk.
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O ne of the consequences of working with
digital images in Photoshop is that you will
soon find yourself struggling to cope with an
ever-growing collection of image files, which

if you are not careful, will consume all the remaining space
on your computer’s hard disk. Most people find it
necessary to store their image files on separate CD or DVD
disks. And the smart photographers will take care to
catalog these disks and possibly create an image library
database, so that pictures can be organized by categories
and retrieved quickly.

I know of a photographer who was asked to ‘go digital’
by his main client. So he bought all the necessary kit,
investing a small fortune in digital hardware. However,
after a few months, the client said he wanted to go back to
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the old days, when he had piles of transparencies to flip
through. This was all because the client had a hard time
tracking down specific images from the growing pile of
CD-ROMs. This anecdote highlights a great potential
weakness in professional digital capture workflow. If you
don’t manage your images efficiently, you will find it
incredibly difficult to track them down later from your
growing digital archives. Sifting through a disorganized
pile of films is not an ideal solution either of course, but at
the end of the day, images must be archived. But the
argument can be made that once you do put in the effort to
archive and manage your digital files properly, the rewards
are that you can retrieve your pictures far more easily than
with a conventional film-based archive.

If you are looking for a sophisticated archival retrieval
system then consider purchasing an image database
program. There are several popular programs that you can
buy and I will be discussing these later, but the Photoshop
CS File Browser now boasts a number of powerful new
features that make it a powerful program in its own right
with which to manage your image files.

The File Browser
The File Browser integrates smoothly with the updated
Adobe Camera Raw plug-in, to enable you to work directly
with your raw image files all within Photoshop (assuming
the camera raw file format is one of those supported).

To display the File Browser you need to click on the
File Browser button icon which is always to be found in
the Options bar palette. Clicking this button will toggle
showing and hiding the File Browser window (see Figure
16.1). But you can also open it on screen by choosing File
➯ Browse... by using the Co L0 shortcut, or by
selecting File Browser from the Window menu. If you have
been used to working with Photoshop 7.0, then the first
thing you notice is that it no longer behaves like a palette.
The File Browser cannot be docked to the palette well, it
remains open on screen until you click the File Browser
button in the Options bar. To open an image, simply

Keeping track of your data
If you use a computer regularly you will
already appreciate the importance of
keeping track of all your office work files
by saving things to their correct folders
just as you would keep everything tidy
inside the filing cabinet. The task is made
slightly easier on the computer in as much
as it is possible to contain all your word
processing documents on the one drive
(and a single backup drive). Digital files
are by comparison too large to store on a
single disk and need to be archived on
many separate disks or tapes. One disk
looks pretty much like another and without
diligent marking, cataloging and storing,
in a year or two it will take forever to trace
a particular picture. I only have to look at
my collection of video tapes to appreciate
the wisdom of indexing – I know there are
movie masterpieces in there somewhere,
but am damned if I can find them when I
want to.
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Figure 16.1 The File Browser interface.
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double-click the thumbnail or image preview. And if you
want the browser window to close at the same time, hold
down the O A key as you double-click.

Rotation and flagging
Lets look at the interface in more detail. At the top there is
a menu display followed by a series of buttons. The two
rotate buttons will rotate the thumbnails clockwise or anti-
clockwise. Note that it is the thumbnail that gets rotated.
The rotation is only applied when you actually open the
image up afterwards, or if you choose ‘Apply Rotation’
from the File Browser Edit menu. Notice how the first
three thumbnails in the File Browser dialog shown in
Figure 16.1, display a small rotate icon next to the file
name, which indicates that they have been marked to be
rotated. There are also some keyboard shortcuts that can be
used here. C[ L[ will rotate a thumbnail anti-
clockwise and C] L] will rotate a thumbnail
clockwise. The Flag button offers a convenient way to
mark favorite images while you are editing a selection of
images. In Figure 16.1, I have flagged an image of the fruit
and you will notice a small flag icon appears next to the
file name. Clicking the Flag button will toggle flagging and
unflagging selected images, or you can use the keyboard
shortcut C L +’ (apostrophe). After you have flagged a
selection of images contained in a folder, you can then use
the File Browser View options to display the flagged or
unflagged images only.

Searching images
The Search function is a new feature which gives
Photoshop the power to perform image searches based on
selected criteria. Although Photoshop is not trying to be an
image database program it is feasible to use it as such. For
example, in my line of work we regularly hold model
castings and each model is normally photographed using a
digital camera and his or her name and model agency name
details are entered into the Description metadata field in
File Info (File Info is discussed later in this chapter). Over

File Browser history
The File Browser made its first appearance
in Photoshop 7.0 (or if you want to be
pedantic, you could say it was also in
Photoshop 6.0 Elements before that).
Photoshop CS has addressed a lot of its
earlier shortcomings is now more like the
tool we always wanted and in my view it is
probably the single most compelling
reason why a photographer should
upgrade to Photoshop CS. The File
Browser is like an Open dialog on steroids.
It is a central component of the Photoshop
interface which allows you to quickly
inspect and compare images at a full
screen resolution, make picture selection
edits, sort images using different criteria
and conduct image searches based on
things like the file name or metadata
content (more of which later).

Saving Workspaces
Remember that after you have configured
the File Browser to suit your ideal way of
working, that you can save this
arrangement as part of a workspace
setting. Choose Window ➯ Workspace ➯
Save Workspace...



Martin Evening
Adobe Photoshop CS for Photographers

474

Figure 16.2 When you click on the Search
button in the File Browser you will see the Search
dialog shown above here. This allows you to
conduct image searches based on single or
combinations of search criteria. The search
entered here matches the one described in the
text and the results of the search (which included
all the model casting sub-folders) are then
displayed in the File Browser window under
‘Search Results’.

the course of several months we build up many hundreds of
model images. Let’s say I need to carry out a search for a
specific model called Sarah, but I can’t remember any
more than that. If I click on the Search button, I can select
Caption under the Criteria section, type Sarah in the text
field and click the Search button. Figure 16.2 shows the
Search dialog and an example of the search results showing
thumbnails of all the files that match this criteria, displayed
in the File Browser window as a semi-temporary Search
Results selection. This means that the Search Results will
remain active up until when you either Quit Photoshop or
make a fresh image search.
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Arranging the File Browser contents
The File Browser window contents consist of a thumbnail
view area that can be expanded to fill the whole window
area, plus four palettes and the browser contents can be
customized to suit your individual requirements. If for
example, you want to use the File Browser to make a
picture edit selection, you can drag the browser window
dividers such that the Folders, Keywords and Metadata
palettes are collapsed and the Preview palette is expanded
to fill as much of the window area as possible. In Figure
16.3, the Preview palette area has been expanded. A
customized arrangement like this will make it easier to
check for small details when sorting through a large
number of images in a folder, such as when you return
from a location shoot and wish to create a short-list
selection of pictures. You can also drag the thumbnails
about within the Thumbnail area. This too makes the File
Browser experience more analogous to editing slides on a
lightbox.

My preferred way of working is to expand the preview
palette as shown, to make it as big as possible. I then use
the right and left keyboard arrow keys to progress forward
or reverse through the image folder contents and if I see a
picture I like, I use the C L +’ (apostrophe) keyboard
shortcut to flag it. I can then select Flagged Images from
the File Browser View options menu, to display the flagged
images only. If needed, I can drag the thumbnails around if
it helps the edit selection process. You can rank the files
displayed in the thumbnail pane to indicate their priority or
importance. L right mouse-down on a thumbnail and
select a ranking option from A to E from the contextual
menu. File ranking can be displayed in the Large with
Rank and Details thumbnail views and you can then use the
file ranking to determine the order of how the thumbnails
are arranged.

Deleting contents
The Delete button can be used to delete selected
images. This action will remove the thumbnail
from the File Browser window and send the
original file to the Trash (Mac) or Recycle bin
(PC). You need have no fear of deleting files in
File Browser, as you cannot delete a file
permanently from within Photoshop, this can
only be effected by deleting the contents of the
Trash (Mac)/Recycle bin (PC) at the Operating
System level. Also, you can only delete a folder
which is empty, when you use the Delete button
(the Trash can) within File Browser.
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Figure 16.3 The palette arrangements within the File Browser can all be customized to suit your own way of working. If you click on the
Expanded View button at the bottom (see Figure 16.1), this will expand the thumbnail view to fill the File Browser window, hiding the
remaining palettes. Thumbnails can be moved around within the thumbnail area, as if you were editing photographs on a lightbox. If you
double-click on a palette tab, such as I have done here with the Keywords palette, this will collapse the palette, hiding the palette contents.
The palettes can be expanded by dragging on the vertical and horizontal dividers. In this example, the Preview palette has been expanded
so that we see a large preview of the selected thumbnail. Note that whenever you save a workspace setting, you are also able to save a
customized File Browser configuration.
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File Browser Preferences
The File Browser preferences can be accessed via the File
Browser Edit menu. The default settings limit building
thumbnails to images of 100 MB or less, but you can
increase this limit if need be. The Custom thumbnail size
can also be increased, although 256 pixels does provide
quite a decent sized thumbnail (see Figure 16.5). The
Allow Background Processing option means that
Photoshop will automatically get on with building all the
thumbnails, reading in the file metadata and build large
previews whenever you make a folder active. This is
important if you have a large number of images to inspect
as it may take several minutes or more to build a complete
cache of the folder contents. This way you can leave
Photoshop to process a folder of images in the background
and when you come to edit through the shots, there is no
waiting for previews to build each time you preview a new
image. I have the High Quality Previews option checked
too because I want to see the best quality previews possible
in the File Browser window. This can matter a lot when
you wish to make fine judgment calls concerning small
areas of detail in the images you are editing. The Render
Vector Files option is not important if you mainly work
with pixel images.

Figure 16.4 The File Browser preferences.

Sidecar and non-image files
The Parse XMP Metadata from Non Image
Files is something I’ll come onto shortly,
but basically you want to keep this
checked as it will enable Photoshop to
read in the metadata from non-image files
such as camera metadata files, also
referred to as ‘sidecar’ files. The reasons
for creating these sidecar files were
explained earlier in Chapter 11. But
basically, sidecar files are a mechanism for
storing essential, edited metadata
information that for various reasons,
cannot otherwise be embedded in the
original file. Sidecar files are linked to
specific images. It is a good thing to keep
this option checked. It means that
whenever you move a file about from one
folder location to another, the associated
sidecar file travels with it.
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Folders palette
The Folders palette displays a folder list view of the
computer contents plus any other disks currently mounted.
The Folders palette is used to navigate the folder hierarchy.
Folders can be expanded or collapsed. Whenever you insert
a CD or DVD disk, you may need to refresh the folders
palette contents which can be done by L right mouse
clicking and selecting ‘Refresh’, or by using the ∞
keyboard shortcut. When you highlight a folder in the
folder palette, all the image files in that folder will be

Figure 16.5 The Custom thumbnail file size can be configured in the File Browser preferences. Using larger thumbnails makes it easier
to compare images inside the File Browser window.
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Figure 16.6 The Folders palette displays a
complete list view of all the folders in your main
hard drive and any mounted disks.

displayed as icons in the main thumbnail display on the
right. Note that Photoshop will only be able to create a
preview of image files it already understands or has a file
import plug-in for. As this is happening, Photoshop will
write a folder cache of all these image thumbnails and
previews to the hard disk, which will be stored within the
Application Support\Adobe\File Browser folder. The saved
cache will save time displaying the thumbnails whenever
you revisit that folder. Incidentally, it can be considered
advantageous to switch on the backward compatibility
option in the preferences as this will speed up the writing
of the thumbnail cache file. There are two cache-related
options in the File Browser fly-out menu. You can purge
the current folder cache or export it, so that a cache is also
saved in the same folder hierarchy. This is useful if you are
preparing a folder of images to burn to a CD/DVD disk,
because the exported cache can then be read by another
Photoshop CS user. If a disk contains a cache that was
exported from Photoshop 7.0, Photoshop CS will be able to
read it, which will save time, but Photoshop CS will still
have to spend time generating the previews.

Keywords palette
Keywording provides a way of grouping and organizing
images within Photoshop. Earlier on in this chapter I
demonstrated how the Search feature could be used to
locate all the models who were named Sarah from within a
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large collection of model casting photographs. But
supposing we wanted to conduct a search restricted to
looking for models belonging to a specific model agency?
Or perhaps we might want to categorize photographs in
other ways as well, separating them according to the
location where they were shot? We can achieve all this by
applying specific keywords to groups of images. Figure
16.7 shows the Keywords palette. To add new keywords,
click inside an existing Keyword set or create a new one
and then click on the New Keyword button at the bottom of
the palette. To assign keywords to one or more images, you
need to make your image thumbnail selection from within
the File Browser and then go to the Keyword palette and
click on the empty square to the left of the desired keyword
to assign one or more keywords from a Keyword set. This
will allow you to apply keywords to multiple images at once.
Keywording can help you search and retrieve images and the
keywords will also be recognized by other image database
programs such as Adobe Photoshop Album (PC only).

Figure 16.7 The Keywords palette can be
used to assign keywords to one or more images
at a time. It can also provide feedback on the
keywords already assigned. In the example
shown here I have highlighted an image and I can
see that it has been assigned three keywords
telling me that it is a model casting photograph,
shot in London and that the model agency is
called Isis.

Delete button

Add new keywordAdd new keyword set
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Image metadata
Several times now, I have referred to the term ‘metadata’ in
this chapter. The best way to explain metadata is to
describe it as being ‘data about data’. These terms may
sound off putting, but the concept of metadata is one you
should be quite familiar with. Librarians use metadata to
classify and catalog books in a library. In the old days they
used index cards to enable you to do a search by author
name or by a book’s title. Everything is now computerized
of course and you will find a computer terminal instead of
card index system down your local library. And in a
computerized system it is possible to record so much more
information about a file and use this information to carry
out sophisticated searches and cross-reference one file with
another.

File Info metadata
The File Info dialog shown in Figure 16.8, has been around
since the early days of Photoshop, yet few people have
ever used it or known much about it. The File Info dialog
was designed to enable you to edit the image metadata
relating to picture content. Photoshop has always supported
the information standard developed by International Press
Telecommunications Council (IPTC) which was designed
to help classify and label images and text files using
metadata. In previous versions of Photoshop, you could
access the File Info via the File menu and use it to title an
image, add the name of the author, add keywords and
inspect the camera capture metadata. File Info is still in the
File menu, but can also now be accessed via the File menu
in the File Browser, or by using the default keyboard
shortcut: COi LAi. The File Info dialog
contains seven sections, some of which are editable, such
as the Description section shown in Figure 16.4 and some
which provide information only, such as the camera EXIF
metadata. Using File Info, one can add the author name,
mark the image as being copyrighted, add a copyright
notice and a URL to your website. In the next chapter we
will be looking at recording actions in Photoshop to help

Metadata everywhere
The most common place use of metadata
these days is the Internet. Use a search
engine and within a matter of seconds web
links will appear on the screen, offering
lots of suggestions for what you are
looking for. Web designers add metadata
tags to the headers of web sites to enable
search engines to catalog them more
effectively. Parents and schools use
metadata to filter out the web content that
children can access. MP3 players use
metadata to categorize your music
collections. Metadata is used in all sorts
of ways and if anything, we seem to have
too much metadata out there! Web search
engines often offer you thousands of
possible links, when you would rather
have your choice narrowed down to a
smaller selection. The trick is for
distributors to provide metadata that is
useful and for retrieval systems to
intelligently sort through the metadata.
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automate the use of the program. It is possible to start
recording an Action, add basic information such as the
above, close the File Info dialog and stop recording. This
action can be used to apply your author details to images
singly or in batches, without having to keep typing in the
same data over and over again. As well as this you can
create a File Info template. In Figure 16.8 I have opened
the File Info for an image and added a description of the
session which I can then apply to a whole folder of images.
Mouse-down on the fly-out menu and choose Save
Metadata Template... Save and name the template. Then
when I select all files in a folder, I can go the File Browser
Edit menu, mouse-down on the Append Metadata item and
choose the recently saved metadata template from the list.

Interpreting the metadata
Metadata comes in many forms. In the early days of digital
camera development, the manufacturers jointly came up
with the EXIF metadata scheme for cataloging camera

Figure 16.8 The File Info palette

Metadata in use
Since version 6.0, Photoshop has been
able to preserve any metadata that is
written into a file. The use of metadata will
play an extremely important role in the
future of digital photography and the way
images are managed. In a lot of cases this
will happen automatically, thus saving end
users’ time and money, when cataloging
their image databases. The Pixel Genius
company I belong to have produced a
freeware plug-in for Photoshop called
MetaReader™, which you can download
from the Pixel Genius website:
www.pixelgenius.com. The plug-in will
display and export to text files any
industry standard metadata embedded in
the file. This allows photographers and
artists to use the exported metadata in a
variety of common database programs.
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Future uses of metadata
It is quite scary to consider the number of
freely distributed digital images out there
that contain no information about the
contact details of the person who created
it. Imagine a scenario in the future where
metadata can be used to embed important
information about usage rights. Imagine
also that a third party developer could
service a web site that allowed interested
purchasers to instantly discover what
specific exclusive usages were currently
available for a particular image? You could
even embed a self-generating invoice in
the image file. If someone tried to strip out
the metadata, you could even use an
encrypted key embedded in the file to re-
import the removed metadata, and/or
update specific metadata information. I
predict that the use of metadata will offer
tremendously powerful advantage to
individual image creators who wish to
distribute their creative work more
securely over the Internet and profit from
legitimate image rights purchases.

information. You may find it interesting to read the EXIF
metadata that is contained in your digital camera files. It
will tell you things like what lens setting was used when a
photo was taken and the serial number of the camera. This
could be useful if you were trying to prove which camera
was used to take a photograph when there were a lot of
other photographers nearby trying to grab the same shot
and also claiming authorship. The EXIF metadata can
describe everything about the camera’s settings, but the
EXIF schema could not be adapted to describe the
information that interests you. In 2001, Adobe announced
XMP (eXtensible Metadata Platform), that to quote Adobe:
‘will establish a common metadata framework to
standardize the creation, processing and interchange of
document metadata across publishing workflows’. Adobe
has already integrated the XMP framework into Acrobat,
InDesign Illustrator and Photoshop. XMP is based on XML
(eXtensible Markup Language) that is the basic universal
format for using metadata and structuring information on
the Web. Adobe has also made XMP available as an open-
source license, so it can be integrated into any other system
or application. Adobe’s enormous influence in this arena
means that XMP will doubtlessly become a common
standard in the publishing and imaging industry. One can
anticipate that Adobe and also third party companies will
want to exploit the potential of XMP to aid file
management on a general level and for specific needs such
as scientific and forensic work.

Metadata palette
Now let’s take a look at the Metadata palette. The metadata
information is divided into sections. The File Properties
and IPTC sections duplicate the File Info dialog contents.
Below that is the EXIF camera data, followed by Camera
Raw data, GPS information and the Edit History log.

As with File Info, the IPTC metadata can be edited
(which is indicated by the pencil icons that appear to the
left of the metadata items). To edit the metadata, mouse-
click the field next to the metadata heading. As I mentioned
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Figure 16.9 The File Browser File menu
duplicates several of the controls already
accessible in the File Browser. For example, to
create a new folder, L right mouse-click
anywhere in the Thumbnail area to display the
File Browser Contextual menu and choose New
Folder. If a thumbnail image is selected in the
File Browser, you can use the File menu to edit it
directly in ImageReady or open the File Info
dialog. The File menu is mostly useful for adding
to and removing folders from the favorites list,
and also for managing the File Browser image
caches.

Figure 16.10 The Metadata palette and Metadata Display Options.

Increasing the font size
If the pixel resolution of your screen
renders these items too small, you can
increase the font size in the Metadata
palette via the palette fly-out menu. This
will make it easier for typing into the
metadata and for locating existing entries
more accurately.
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earlier, the amount of information displayed here is vast
and more than you really need to know. If you open the
Metadata display options (shown in Figure 16.9) you can
exert control over how much metadata is displayed in the
palette. Each metadata item has a checkbox against it. This
allows you to show or hide individual items. If the Hide
empty fields box is checked, the checked items will only be
displayed in the Metadata palette if there is an
accompanying data entry.

Edit history log
If the history log options are enabled in the General
preferences, an edit history can be recorded in either the
file metadata, as a separate text file log, or both. The Edit
history has many potential uses. A log file will record how
much time was spent working on a photograph and could
be used as a means of calculating how much to bill. In the
world of forensics, the history log could be used to verify
how much (or how little) work was done to manipulate an
image in Photoshop. And the same arguments can apply to
validating images that are used to present scientific
evidence

File Browser management
There will be many folders in your computer system, but
most likely there are only a few you will wish to keep
returning to with the File Browser. If you use the File menu
to assign specific folders as Favorites, these folders can
always be accessed swiftly using the Viewed folder
directory path and selecting under ‘Favorites’ just next to
the right of the File Browser menu items.

Every time you open a folder in the File Browser it will
check to see if there is an image cache located in the
Application Support\Adobe\File Browser\Photoshop CS
folder. The image cache has two components: the image
metadata and thumbnail cache. If a cache is present, the
inspected folder will display the archived thumbnails,
previews and metadata instantaneously. This works fine so
long as the folder is being inspected on the computer that

Figure 16.11 The history log options are
configured in the General preferences. The
history log content can record: sessions only
(such as the time a file was opened and closed); a
Concise log listing of what was done in
Photoshop; or as shown here, a detailed log,
which will include a comprehensive list of the
settings applied at every step. If you choose to
embed the history log in the file metadata, the log
can be viewed in the File Browser Metadata
palette.
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created it and the folder name has not changed since the
image cache was created. Every time you create a folder of
images the best solution is to go to the File menu and
choose Export Cache. This action will save a copy of the
thumbnail and image cache to the same folder. The
advantage of doing this is that it does not matter how you
may rename the folder later, the folder image cache will
still be recognized. It is particularly important to export a
cache to the folder whenever you are about to burn a CD or
DVD disk.

File Browser automation
The File Browser has become a hub for being productive in
Photoshop. The Automate menu items will let you launch
various Photoshop automated routines, such as Batch
actions. Select a group of images in the File Browser,
choose Batch... and configure the dialog to run a batch
action processing routine on the selected photos. You can
read more about this and all the other automation features
in the following chapter on Shortcuts. But using the
example of the Web Photo Gallery, which was covered in
the previous chapter, you can flag a selection of images,
choose show flagged images only, rearrange the thumbnail
order as desired and then build a Web Photo Gallery of this
flagged selection directly within the File Browser.

Figure 16.12 Sometimes flagging alone does
not allow enough distinction to separate your
images when making an edited selection. This is
where applying a rank to an image can come in
useful. The easiest way to do this is to choose
Show Rank in the File Browser View menu (see
Figure 16.19). This will display the Rank box
below each thumbnail (see Figure 16.13). Click
in the box next to where it says Rank and type a
letter or number. To assign ranking to multiple
images, make a thumbnail selection and choose
Rank from the Edit menu. The Rank Files dialog
will appear. Type in a letter or number and click OK.

Flagging and Ranking
The easiest way to approve an image and
mark it separately from the rest is to use
the File Browser Flag button or the
Command-’ keyboard shortcut. I find that
flagging preferred images works best for
me and I rarely need a more detailed
system to categorize my photographs. But
if you want to apply a more structured
form of marking then I suggest you use the
image ranking feature. Select the Rank...
item in the File Browser Edit menu or
Control/Right mouse-click in the
Thumbnail dialog and choose Rank... If
Show Rank is selected in the File Browser
View menu, all you need to do is click in
the empty field next to the Field that says
Rank. Any scheme can be used for ranking
images. In Photoshop 7.0, the File
Browser suggested using A, B, C, D... But
you could just as easily rank your images
using numbers instead.
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Figure 16.13 The File Browser Edit menu
contains options for flagging and ranking and
making selections of images within the File
Browser. Ranking provides a more flexible
approach beyond the basic flagging of selected
images. The Append and Replace metadata sub
menus enable you to apply or replace metadata in
image files, using templates saved from the File
Info dialog to selected images.

To rename an image in the File Browser, you just
double-click the file name and enter a new one. But if you
make a selection of thumbnail images in the File Browser,
you can run Batch Rename from the Automate menu. This
will enable you to rename the selected images any way you
like (see Figure 16.15). You can rename the files in the
same folder or rename and move them to a new (specified)
folder. It would be useful to have had a Copy to new folder
option, but if you do want to, copy the selected images
before renaming them. Create a new folder, and O A
drag the selected thumbnails across to the new location
(O A will create a duplicate file). In Figure 16.15
notice how you can use the multiple fields to construct a
batch renaming scheme. The first field contains two letters
that are a shorthand for the client name. This is followed by
‘03’ for the year 2003, followed by a four digit serial
number and lastly the file format extension in lower case.
If you want the serial number to begin at a number other
than 0001, enter the number to start the sequence from in
the box below. Incidentally, if you are reading this and
using Photoshop 7.0, there is a work around: instead of
selecting 4 Digit Serial Number, type in the start number
between two hash signs. So to start the numbering from
0234, type in: #0234#. Lastly, I suggest if you are a Mac
user, you check for Windows compatibility. The scheme I
use here will help me catalog up to 10,000 images per year
per client.

Editing the Batch renaming fields
When you edit the Batch renaming fields,
the simplest way to do this is to mouse-
down on a field entry and choose a preset
item, such as today’s date or a four digit
number, from the list. The fields are edited
in order from left to right and top to
bottom. You can, as described in the text.
Manually insert a field by typing
something in. Consecutive fields cannot
be left blank and the very last field must
end with ‘extension’, or ‘EXTENSION’, if
you want to use upper case. Above you
will see an example of how the renaming
structure will be applied. Don’t be
concerned by the fact that this has a GIF
extension, it is only an example of how the
naming will work!
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Figure 16.14 The File Browser Automate menu.

Applying Camera Raw settings
Another useful thing in the Automate menu
is the Apply Settings function. Lets say
you have a folder of raw camera files, you
open one of the images and make some
camera raw adjustments to the picture.
You either click OK to open the image
using these settings or Hold down the
O A key and the OK button will
modify to say: ‘Update’. Now once a
camera raw setting has been produced for
one image you can select all the other
similar images, go to the Automate menu
and choose Apply Camera Raw Settings...
and be shown the dialog in Figure 16.16.
If all that you want to do is apply the exact
same settings, to the other camera files,
choose ‘Previous Conversion’, click
Update and you are done. However, if you
want to apply some settings globally and
not others, in Advanced mode, you can
deselect the various individual camera raw
settings in the left hand section of the
dialog. This is actually a pretty cool
feature. Imagine that you have just shot a
series of photos and they all require the
same type of settings adjustment in
Camera Raw. All you have to do is work on
one image and then apply these settings to
all the rest of the images. When it comes
to opening up and converting the images,
you can adjust the settings again if you
wish. But by being able to apply batch
settings, you can use the Automate menu
to build Web Photo Galleries, contact
sheets etc., that are more representative of
the finished results.

Figure 16.15 The Batch Rename dialog.

Figure 16.16 Apply Camera Raw Settings



489

Image management
Chapter 16

Figure 16.17 On-line Services Figure 16.18 The Sort menu options allow
you to arrange the displayed thumbnail images
by ascending or descending order using any of
the criteria listed in the menu. Normally this is
left at the default File name setting. But if you
selected Rank for example, the images would be
displayed according to the ranking priority, with
all the Rank A images appearing before the Rank
B images and so on.

On-line Services
Adobe have been keen to promote the file sharing and on-
line services aspect of Photoshop CS. At the time of
writing it is hard to predict how Photoshop customers will
respond to the availability of this service. So far, there is an
organization called Shutterfly who are collaborating with
Adobe to provide an on-line printing service and I
anticipate that others will follow. To use Shutterfly, launch
On-line Services from the File Browser Automate menu
and follow the dialog instructions to create yourself an
account with Shutterfly. Selected images can then be
uploaded from the Photoshop File Browser to your account
folder with Shutterfly. From there on you can explore the
various print options and finally place an order to have a
print made and delivered. On-line print services have
become very popular in recent years, mainly due to the
speed and popularity of broadband Internet services
making it easier to upload large image files. An on-line
printing service can prove useful if you need to make
enlargements bigger than your own printer can handle or if
you wish to produce multiple print copies at a reasonable
cost.
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Managing your images
I began this chapter with an anecdote about a photographer
who had been left stranded by a client who was unable to
manage the digital image files. Whether you are a
professional or amateur photographer, it should be clear
that you have to plan to do something to manage your
pictures or else you too will become just as frustrated. The
File Browser tools are designed to make it easier for you to
catalog and locate images and you may also want to
consider using a separate stand-alone image library
program to administer your image collections. Mac OS X
users have iPhoto as standard on their computers, which is
an Apple only application. Adobe produce a program called
Photoshop Album (PC only), which integrates nicely with
the File Browser in Photoshop, recognizing and using the
Keyword and metadata structure used in Photoshop CS.
Image management is something we all need to have. For
example, if you want to manage your music files, a

Figure 16.19 Using the View menu,
thumbnail images can be displayed at different
sizes, including the new Custom Thumbnail size
(see Figure 16.5). The ‘Details’ view shown in
Figure 16.20 will display the thumbnail along
with some of the more useful file metadata
information. If you are wanting to rank the
images, then make sure the Show Rank option is
checked in the menu list. I normally prefer the
folders to be displayed in the File Browser as I
don’t have to rely solely on the Folders palette to
navigate to access the folder’s contents.
Unreadable files refers to non-image files, such
as Word documents. I prefer to leave this item
unchecked, but it can otherwise allow you to
inspect a complete list of documents in a
particular folder.

Figure 16.20 The Details view provides some of the file metadata information
alongside the image thumbnail, which makes it easy at a glance to see things like the
color mode and profile space an image is in, plus the file size dimensions. In this
illustration, you can see that I am adding a title into the metadata Description tag. To
make it easier to enter the data, I have increased the font size of the metadata palette.
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program like iTunes will update your music database
automatically. When A CD is inserted, iTunes will query an
on-line database, downloading the album title, artist, track
listings and genre of music. This is an example of metadata
in action, which is used to help you manage your music
collections as easily as possible. In this example where you
are converting music files to an MP3 format, the
cataloging is effortless because it happens in the
background automatically. But when you want to catalog
image files, these are usually original documents. And the
only way to catalog them is to do it yourself. I have
described in this chapter some of the ways that you can go
about handling this process in Photoshop, but quite likely
you may find that this finishing off process can be
managed better using a dedicated image library software
program. Having said that, it is interesting to conjecture
how one day it might be possible to use the Global
Positioning Satellite (GPS) metadata to automatically
complete the location metadata fields. To explain what I
mean by this, it is possible with some setups to record a
GPS reading at the time of capture and embed this
information in the image file. Take a look at the Metadata
palette contents and you will see that there is already
provision to display the GPS data. Now imagine that there
was an on-line database (similar in principle to the one
iTunes references) that could read in the GPS data and
translate this into meaningful location information. So the
images shown in Figure 16.20 of LH2 Studio, could
automatically be cataloged as being located in ‘Stoke
Newington, London’.

The digital lightbox experience
Let’s now look at the process as a whole of bringing digital
images into Photoshop and how you can manage them
successfully with a view to maintaining a digital image
library archive. These are the steps I use in the studio and
on location. That is a brief summary of how I typically use
Photoshop to manage my photographs, automating the
process as much as possible and at the same time maintain
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1 The process begins with the digital captures which are always shot using Raw mode being copied from the media card to the computer.
All media cards are vulnerable to damage, but so too are computer hard drives. I copy the files across to a laptop computer in the studio,
initially, copying the files across to a LaCie FireWire pocket drive. This is the simplest way to get the files off of the card without having to
worry if they are in the right folder or not, which is important when you are in a hurry.

2 Next, I will make a backup of these files to a designated folder on the main computer hard disk. At this point it is now safe to delete all
the files off the card So it can be used again.
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3 In Photoshop, I will open the File Browser and select the camera file folder on the main computer hard disk (not the one on the pocket
drive) and once the thumbnails have been generated, select those that need to be rotated. I will choose Select All from the File Browser Edit
menu or use the Ca La keyboard shortcut followed by Batch Rename from the Automate menu. You can use any identification/
numbering system you like. The method shown here is the one described on page 485.

4 The Canon camera has a neat feature whereby I can program it to automatically embed my name as the author whenever I shoot an
image. But I can also make sure every photograph I process in Photoshop is copyright marked with my name again plus any other details,
using the Append Metadata command as described on page 480.
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5 At this stage the photographs will be ready for
editing. One of the key demands made of the
Photoshop engineers was that the File Browser
should become the digital equivalent of a
photographer’s lightbox. I like having the ability
to move the dividers around so that the preview
image can fill the screen as much as possible.
You may find it easier to create and save a
custom Workspace setting for making edit
selections where the Preview palette is
maximized to fill as much of the screen area as
possible.

6 I can now navigate from one image to the next
using the keyboard arrow keys, and flag favorite
pictures using the C L+’ keyboard shortcut.
The favorite, flagged images can be viewed in
isolation and at this point I may want to make the
thumbnail size bigger and rearrange them in
order to make a final image choice. If I want to
show the final selection to friends or a client, I
can choose to make a Web Photo Gallery of the
edited photos and upload this to my server.
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DVD as an alternative to CD
Recordable DVD drives have become
increasingly popular and are often
supplied as standard with some computer
models. Recordable DVD disks are capable
of storing 4.7 GB of data. But again, to be
realistic, I would knock that figure down to
something more like 4.2 GB as the actual
amount of data you can store on a disk.
Early DVD drives were x1 speed and
painfully slow to work with. But you can
now get x4 speed DVD drives, which from
my point of view make an appreciable
difference to the time it takes to archive my
data. I typically shoot around 300-400 raw
captures during a day’s shoot and usually I
am able to backup these raw files to a
single DVD drive. The only problem with a
CD or DVD disk is that if it gets damaged
you lose everything and that might mean
losing a hefty chunk of valuable data. So
make an extra backup copy of important
data and archive this separately.
Recordable disks also have a finite life
span. And who is to say if CD or DVD will
not be superseded by some other form of
recordable media? And furthermore, if you
archive raw camera files, will you always
have the software to interpret these? In this
industry a lot can happen in a matter of
just a few years.

a backup of all the raw data on a separate hard drive. When
adding new images to the collection throughout the day, I
will follow all the above steps, except when using the
Batch Rename function to renumber the photos, I have to
start the numbering so as to follow on from the last image
in the previous batch.

Storage Media
The biggest bottleneck in the digital management process
right now is the time it takes to archive data to a storage
medium. Over the years we have seen many types of
storage media systems come and go. But the most popular
media these days are recordable CDs. Just about every
computer sold today will have a built-in CD drive that is
capable of reading and writing disks. Some CD disks can
theoretically hold up to 700 MB of data, although 650 MB
is probably a more realistic upper limit to aim for. Not so
long ago, 650 MB used to be considered an enormous
amount of storage space, but these days it won’t go very
far. My layered master images often exceed 200 MB and if
storing to CD, I would therefore have to separate my files
into two or more folders before burning the disks, taking
care that none exceeds the capacity of the CDR media. A
colleague of mine, Seth Resnick, has adopted a very
thorough approach to working with digital captures and I
have learned a lot from attending his seminars on
managing the digital workflow. Seth argues that it makes
sense to process all the selected favorites as 16-bit TIFFs
and archive these on an actual hard drive as well as a CD
or DVD. A 250 GB external hard drive is not too expensive
and if you accumulate around 25 GB worth of data for each
job, then it only costs a tenth of the cost of a hard drive to
store these. He also points out that in all the years he has
been working with computers that hard drives are the one
standard that has survived all the various types of
recordable media. For example, does anyone now
remember Syquest disks?
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Figure 14.2 The Print with Preview dialog.
This dialog interface allows you among other
things to accurately position the image on a page
and alter the scale at which it will be printed.
Deselect the Center Image checkbox and you can
enter precise measurements in the Top and Left
edge boxes. When the Bounding box is made
visible, you can drag the box and box handles to
visually arrange the page position and scale. If a
selection is active before you select Print Options
and Print Selected Area is checked, the selected
area only will be printed. Under the Show More
Options, you can add print information such as
calibration bars, captions and crop marks. When
the Include Vector Data option is unchecked, it
will rasterize the vector layer information, such as
type at the image file resolution. If it is checked, it
will rasterize the vector information such as type
much crisper at the full printer resolution.

Making an inkjet print
There are four Print menu items in Photoshop: The Page
Setup, the ‘System’ Print dialog, Print with Preview and
Print One Copy. In Photoshop CS, Cp Lp will open
the traditional System Print dialog and COp
LAp will open the Print with Preview dialog (which
is the one I will be using throughout in this chapter). If you
prefer this behavior to be reversed, you can easily switch
these key settings in the keyboard shortcuts. Before making
a print ensure that the correct printer is selected. On Mac OS X go
to the Applications folder, open the Utilities and launch the
Print Center application. On a PC, choose File ➯ Print and
click on the Setup button to select the printer driver.

I prefer using the Print with Preview dialog because it
shows how the Photoshop document will print in relation
to the page size and I can set the all-important color
management options. When the Center Image box is
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deselected, you can position the image anywhere you like,
by dragging the preview with the cursor, although there are
some issues over the accuracy of the preview placement
when using Mac OS X. Or you can position and resize
within the specified media chosen, using the boxes at the
top. You cannot alter the actual number of pixels via this
Print dialog. Any changes you make to the dimensions or
scaling will always be constrained to the proportions of the
image. In the Output options below that, click on the
Background... button to print with a background color
other than paper white. For example, when sending the
output to a film writer, choose black as the background
color. Click on the Border button to set the width for a
black border. But be aware that setting the border width
can be an unpredictable business. If you set too narrow a
width, the border may print with an uneven width on one or
more sides of the image. On the right, you can select
whether or not to print the following: Calibration Bars,
which will print an 11-step grayscale wedge on the left and
a smooth gray ramp on the right. If you are printing CMYK
separations, tint bars can be printed for each plate color.
The registration marks will help a printer align the separate
plates. The crop marks indicate where to trim the image
and the Bleed button option which lets you set how much
to indent these crop marks. Checking the Caption box will
print any text that was entered in the File ➯ File Info box
Description field. Check the Labels box to print the file
name below the picture. Note that all of this is dependent
on there being enough border space available surrounding
the print area to print these extra items and whether you are
using a PostScript print driver. The print dialogs
reproduced here show the Epson 1290 inkjet printer
settings and instructions for Mac and PC. The interface and
main control will be fairly similar for other makes of inkjet
printers, but not identical. The first example shows how
you how to go about making a print from an RGB image in
Photoshop using one of the Epson 1290 printer profiles that
were automatically loaded when I installed the printer
driver on my computer.
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1 The first thing you need to do is go to the Page Setup dialog and make sure the right printer is selected (you will have to do this each
time in Mac OS X). Now choose a paper size that matches the paper you are about to print with and choose the right orientation: either
portrait or landscape. There is no need to adjust the scaling percentage here as this can be accomplished more elegantly in the Print with
Preview dialog coming up next. On a PC you click on the Properties... button (see dialog on page 409) to select the paper size and print
orientation.
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2 If you choose File ➯ Print, you will jump straight to the dialog shown in step 3. But I recommend that you always start by choosing File
➯ Print with Preview because this will enable you to correctly configure the color management options. Most of the features have already
been covered in Figure 14.2. Note that the Show More Options are checked here and the Color Management options are being displayed.
The source space should be left as Document and in this example the source space of the profiled RGB file is Adobe RGB. Next select the
Print Space. Mouse down on the Profile menu and a list of possible profile spaces will appear. Assuming you have been supplied some
printer profiles during the installation process, you want to select a profile that includes both the name of your printer and the type of
paper that you are printing to. You can do this if you are using an Epson printer and the Mac OS X operating system. But if you are using a
PC, Epson will only offer one choice of profile (it’s more of a setting really). If you are printing to an Epson with a PC, select ‘Printer Color
Management’ from the Profile menu. Do this and follow all the remaining steps exactly, paying special attention to have ICM switched off.
The actual profile selection on a PC will be determined when you select the paper type in the next step. In Mac OS X, the rendering intent
can be set to Perceptual or Relative Colorimetric and with Use Black Point Compensation switched on. These rendering options will be
disabled on a PC, but will be available if you are selecting a custom profile instead.
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3 Click the Print... button in Print with Preview and you will be taken to one of the Print dialogs shown here. No preset settings have been
saved yet. In Mac OS X, mouse down on the Copies and Pages pop-up menu and choose ‘Print Settings’. On a PC, click on the
Properties... button

4 In this section you need to select a media type that matches the paper you are going to be using. In this example I am printing with
Epson’s Premium Photo Glossy paper. If you are printing in color, make sure the Color ink button is checked. In Mac OS X, click on the
Advanced Settings button and choose a print resolution (1440 dpi will produce nice smooth results). A higher print resolution will produce
marginally better looking prints, but will take much longer to print. On a PC, click on the Custom button in the Printer Properties dialog,
select the media type, click on the Advanced... button and proceed to the next step.



Martin Evening
Adobe Photoshop CS for Photographers

502

5 In the Advanced section on a PC you can now set the print resolution quality. And in the Color Management section click on the No
Color Adjustment button. This is because you do not need to make any further color adjustments – the print driver already knows the
source space color and the destination space, plus it knows the print resolution and the driver has all the information required to produce
an optimum color print on the paper you have selected. In Mac OS X, go to the Color Management print settings option and click on the
No Color Adjustment button. All you have to do now is click on the Print button at the bottom and wait for your image to print.
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Building a custom printer profile
How pleased are you with the results that you are getting
so far with your printer? If you followed the previous steps
carefully, then you should be getting the colors to near
enough match what you are seeing on the display. And if
not, then I suggest you check the calibration of your
display and rebuild the monitor profile. It is never possible
to create a complete match between the display and the
print, even under ideal light viewing conditions. But if you
want to take your color management a step further, why not
consider having a custom profile built for your favorite ink
and paper combinations? If you don’t have the necessary
profiling kit and software, the most obvious thing to do is
to contract the work out to a specialist service provider. I
have recommended and used Pixl in Denmark myself in
the past and Pixl are offering a special discount coupon to
readers of this book that will entitle you to a discount on
their remote printer profiling services. More details are in
the back of this book and on the CD-ROM. The next series
of screen shots lead you through the steps required to print
out the target shown in Figure 14.3.

Figure 14.3 This is an example of a Gretag
Macbeth color target which is used to construct a
color ICC profile. Each file must opened in
Photoshop without any color conversion and the
file is sent directly to the printer, again without
any color modification and the print dimensions
must remain exact. If it is necessary to resize the
ppi resolution, make sure that the Nearest
Neighbor interpolation mode is selected. The
print outputs are then measured using a
spectrophotometer and a profile can be built from
these measurements. Thomas Holm of Pixl in
Denmark (www.pixl.dk) provides a very good
remote profiling service. Test targets like the one
above can be downloaded from his website. All
you have to do is make ‘neutral path’ prints (see
pages 412-415), send these to Pixl and they will
email a profile back to you.
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1 Begin by opening the test chart file (or series of files) such as the one shown in Figure 14.3. These will be included as part of any print
profiling package or supplied to you by the profile building service provider. This file will have no embedded profile and it is essential that
it is opened without making any conversions and always printed at the exact same print size dimensions.

2 Choose File ➯ Print with Preview. Configure the Page Setup as shown in the previous step-by-step example. The source space should
be Document: Untagged RGB. The Print Space profile must be set to ‘Same as Source’. Do not adjust the scale – this must remain at
100%. The idea here is that you want to create a print output of the unprofiled data without applying any printer color management. Now
click Print...
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3 In Mac OS X, choose the appropriate media type and the desired print resolution in the Print settings section. In this example, we are
building a profile for the Epson Heavyweight Matte paper, at a print resolution of 1440 dpi. On a PC, click on the Custom button, choose
the media type and click on the Advanced button.
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4 In the Advanced section on a PC, select the printer resolution. In the color management section you can select ‘No Color Adjustments’
as before. But when preparing to profile an Epson six color dye inkjet like the 1290, you may want to try checking the Color Controls
settings instead. Keep all the controls set to zero and select the Photo realistic mode and a Gamma of 1.8 (I have also had success
building profiles at a gamma of 2.2). The main thing to remember here is that whichever route you follow, you should now save these print
settings. These are to be used when you print using the custom profile. Go to the Presets menu, mouse-down and choose Save... This
print setting was named: ‘neutral path 1440 Matte HW’. We are now ready to print the test target.
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5 Once the print has been allowed 24 hours or more to stabilize, it can be measured and a profile built. If you are using a remote profiling
service, mail the prints off and wait for them to email you back your ICC profile. The profile will be applicable for use with your printer,
using the same ink sets and with the same media/paper type and print resolution. To test the profile, choose the custom printer profile as
the destination print space and choose the Perceptual or Relative Colorimetric rendering intent with Black Point Compensation checked. If
you are using a PC the instructions are exactly the same as for a Mac.

6 After you click Print... make absolutely sure you select the same preset setting that you saved when creating the target print from your
printer. And that’s it. Mac OS X users will want to pay special attention to check that the correct printer and page setup settings are always
selected correctly, but other than that you should expect to see a very accurate color print, providing that you have remembered to calibrate
and profile your monitor display as described in Chapter Three.
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Perfect results from your printer profiles
There is no such thing as a perfect printer profile, but you
should be suitably impressed by just how good the results
can be and appreciate the pleasure of seeing your
photographs print almost exactly the way you intended.
But to achieve such excellence you have to use a calibrated
light viewing box to view the printed colors correctly. All
inkjet prints take a while to dry after they come off the
printer. A print produced using the Epson 1290 inks will at
first look particularly green in the shadows, but after a few
hours you will notice how the ink colors stabilize and the
green cast eventually disappears. This is why you are
advised to wait at least 24 hours before measuring your
printed target prints. Then there is the issue of what is
commonly referred to as ‘metamerism’. This refers to the
phenomenon where when viewing under different lighting
conditions, the ink dye/pigment colors will respond
differently. This problem can be particularly noticeable
when a monochrome image is printed using color inks.
Although the color management can appear to be working
fine when a print is viewed under studio lighting, if this
environment is changed, and the print is viewed in daylight
from a window, the print can appear to have a green cast.
There was an example of this with the early Epson
Ultrachrome 2000 printer where the pigment-based ink
suffered from this green-shift in daylight problem. The
later Ultrachrome printers have almost managed to resolve
this.

Even despite your best efforts to produce a perfect
profile, you may just find that a specific color on the
display does not match exactly. I sometimes see this
happening with the skin tones in a portrait. Although I
usually obtain a perfect match with a specific ink and paper
profile combination, sometimes the printed result is just a
fraction out on an item of clothing or the skin tones, but
every other color looks just fine. If you know what you are
doing it is possible to tweak profiles using a program like
Gretag Macbeth’s ProfileMaker Pro. But I often just add a
temporary hue/saturation adjustment layer use this to make

Inkjet papers
The optical brighteners contained in many
of today’s inkjet papers can also bring
about quite a noticeable shift in the way a
print is perceived under different lighting
conditions. If there is a high amount of UV
light present the whites will look much
brighter, but also bluer compared to a print
that has been made using a paper stock
such as the Tecco/Best Remote Proof 9180
or Tecco/Best Proof 9150 papers, which
are ideally suited for CMYK proof printing
and viewed using controlled lighting with
a color temperature of 5000 K.
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a minor correction by targeting say, the reds of the skin
tones and shifting them to become 2-3% more yellow. But
another more obvious reason why there may be a
difference in the colors seen is that the color gamut of the
printer is not the same as the gamut of the display on which
you are viewing the image. This is where soft proofing can
sometimes help you get more predictable results.

Soft proofing via the display
When you carry out a color mode conversion or a Convert
to Profile command, the color data is converted to the
destination/device color space. When the file is in this new
space, Photoshop will continue to color manage the image.
If you are converting an RGB master to the working
CMYK space, Photoshop will simulate the CMYK print
output appearance on the monitor after the file has been
converted to CMYK. This is known as ‘soft proofing’. A
real proof is a hard copy print produced by a contract
standard proof printer – soft proofing is therefore a term
that is applied to using the monitor as a proofing device.
The monitor will never be as accurate when it comes to
showing how every CMYK color will reproduce, but it is
usually close enough for carrying out all the preparation
work, before reaching the stage where a final contract
proof is demanded. Good quality displays such as the
Apple Cinema display or Sony Artisan CRT monitor, are
better at reproducing CMYK colors on the screen.

If you are editing an RGB master and go to the View ➯
Proof Setup menu and select Working CMYK (which is the
default setting), you can preview how the colors will look
if you convert from RGB to the working CMYK color
space using the default rendering intent. If you choose the
Custom... option you can select any profile space you want
from the pop-up list. Name and save the custom proof
setting as a ‘.psf’ file in the Users\username\Library\
Application Support\Adobe\Color\Proofing folder (Mac
OS X), or the Program Files\Common
Files\Adobe\Color\Proofing folder (PC). This saved proof
setting will then be appended to the bottom of the list in

Proof Setup
If you want to preview the outcome of a
color mode conversion, you do not have to
convert the color data. Instead, Photoshop
is able to calculate a screen preview only,
while keeping the color data in its original
space. This can be done by choosing View
➯ Proof Setup ➯ Custom... or any of the
other listed color spaces. The Photoshop
color management system therefore
enables you to simulate any CMYK or RGB
print output (i.e. Pictrograph, film writer or
inkjet printer) without having to carry out a
mode conversion first.

The Proof Setup is not just limited to
CMYK output. You can use the Proof
Setup to preview RGB conversions to RGB
output devices or do things like preview
how a prepress grayscale file will appear
on a Macintosh or Windows RGB monitor.
And you can load a custom profile for your
printer to gain a more accurate preview of
how an image will print.

Each new window view can preview a
different proofing setup. So for example,
you can create several new window views
of the same document and compare the
results of outputting to various types of
press output directly on the display.
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Proof Setup. When a proof setting is selected in the Proof
Setup you can preview the colors in this space by choosing
View ➯ Proof Colors. Cy Ly is the default
keyboard shortcut and this will toggle the preview on and
off, making it very easy for you to switch from normal to
proof viewing mode. The document window title bar will
also display the name of the proofing space after the color
mode: RGB/Working CMYK.

Simulate Paper White and Ink Black
Checking these options will modify the appearance of the
preview that can be obtained via the Proof Setup dialog, so
that the soft proof shows more accurately how a file might
actually reproduce after it is converted to CMYK and been
printed. To explain this a little better, when you select
Proof Colors, Photoshop takes the current display view,
and converts it on-the-fly to the destination color space
selected in the Proof Setup. The data is then converted back
to the RGB monitor space to form a preview using the
relative colorimetric rendering intent and with black point
compensation switched on. The Simulate: Black Ink option
will simulate on screen the actual black density of the
printing press. Simulate: Paper White will use an absolute
colorimetric rendering to convert the proof color space data
to the monitor space, simulating the paper white and black
ink colors. However, the Paper White simulation only
works if the CMYK profile used is made on the actual
paper stock to be used for printing, and only if this paper
doesn't have too much optical brightener in it. Otherwise
the results will look bluish on screen. It is rather
disappointing to see the display preview image deteriorate
in front of your eyes this way, so I follow Bruce Fraser’s
advice and try looking away from the display just prior to
checking these press simulation settings!

Color proofing for press output
If you are supplying digital files for repro, then you will
want to obtain as much relevant information as you can
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about the press, paper stock and print process that will be
used to print a job. If the person running the printing press
or repro bureau is cooperative and understands what you
are asking for (these are big assumptions, I know), they
will be able to supply you with a proofing standard ICC
profile or printing inks and other specifications for the
press. Enter these in the Edit ➯ Color Settings ➯ Working
Space ➯ CMYK ➯ Custom CMYK dialog, as described in
Chapter Thirteen. Convert your RGB file to CMYK and
save it as a TIFF or EPS file and supply this with a targeted
CMYK print proof which shows the printer how the
enclosed file should be expected to print within the gamut
of the specific CMYK print process. You could also supply
an RGB file tagged with an ICC profile, as well as the
proof. But be warned, this will only work if it is clearly
understood beforehand and accepted that the recipient will
be carrying out the conversion to CMYK and using the
CMYK proof as a guide. If you send RGB files to printers,
be careful to label RGB folders as such and make every
effort to avoid any potential confusion down the line.

Figure 14.4 Use the Proof Setup menu to
select the device you wish to soft proof with,
whenever you select the Proof Colors command
(Cy Ly). Under the Custom... option
you can select the profile of your printer – in this
case, US Web Coated (SWOP) v2. Checking the
Preserve Color Numbers box will preview how
the image would print if the data was sent to the
printer without any conversion.

Realistic proofs
When you supply a CMYK proof you are
aiming to show the printer how you
envisage the picture should look in print.
A proof should be produced using the
same color gamut constraints as the
halftone CMYK process. That way the
printer will have an indication of what
colors they should realistically be able to
achieve.
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Inkjet technology is ideal for producing excellent
quality ‘targeted’ CMYK prints that can be used as either
an ‘aim’ print or contract proof by the printer. The term
‘aim’ print most justly describes the appropriateness of a
standard Epson inkjet output, when used as a guide for the
printer who is determining how to reproduce your image
using CMYK inks on the actual press. The term contract
proof is used to describe the same type of thing, except it
refers to a more precise form of CMYK proof, one that has
been reproduced by an approved proofing device. These
include the Rainbow and Kodak dye-sub printers, the
Epson 5000 inkjet (with RIP) and prepress bureau service
proofs like the Dupont Cromalin™, 3M Matchprint™ and
many others. Inkjet printers such as the IRIS iProof are
essentially taking over the proofing industry, as many press
houses move to Computer to Plate technology (CTP), thus
eliminating the need for film at the proofing stage. The
contract proofing devices benefit from having industry-
wide recognition. It is safer to supply a digital file together
with a proof which has such a seal of approval. The printer
receiving it knows that the colors reproduced on the proof
originated from a contract device and were printed from
the attached file. Their job is to match the proof, knowing
that the colors in the proof are achievable on the press.

Figure 14.5 shows the Print with Preview dialog for an
Adobe RGB image that is currently being soft proofed with
the Custom Proof Setup using an ‘Offset print Euro
catalog’ color space profile. So the image to be printed is in
RGB, but it is currently being soft proofed in the above
CMYK color space. If Proof is selected as the source
space, it is possible to use this CMYK preview as the
designated source space and simulate the restricted CMYK
gamut of the press on a desktop printer (using the default
rendering intent in Color Settings). In the Print Space
section the profile used is a custom print profile that was
created by the method described earlier. It is a profile for
the Epson Heavyweight Matte paper, to be printed on an
Epson 1290 printer.

Truer whites
If Relative Colorimetric is used as the
rendering intent, the print output will print
using the restricted gamut of the target
CMYK space, and will map the whitest
point of the CMYK proof space to the
whitest point of the profiled paper setting.
This produces a restricted gamut print with
nice clean whites. If you select the
Absolute Colorimetric rendering intent, the
print output will print using the restricted
gamut of the target CMYK space, but will
reproduce the whites to match the true
white of the target press. What this means
is that the whites may appear duller than
expected. This does not mean the proof is
wrong, it is the presence of a brighter
white border that leads to the viewer
regarding the result as looking inferior. To
get around this perception try adding some
extra white canvas in Photoshop to the
outside image you are about to print. When
the print is done trim away the outer paper
white border so that the eye does not get a
chance to compare the dull whites of the
print with the ultra white of the printing
paper. In all cases the Black Point
Compensation button must be deselected.
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PostScript printing
When you print a document, graphic or photograph, the
data has to be converted into a digital language that the
printer can understand. Printing images directly from
Photoshop is a fairly easy process. If you try to print
anything directly from a page layout program, the printer
will reproduce the screen image only. The text will be nice
and crisp and TIFF images will print fine, but placed EPS
images will print using the pixelated preview. This is why
we need PostScript, which is a page description language
developed by Adobe. When proofing a page layout via a
PostScript printer, the image and text data in the layout are
processed separately by a Raster Image Processor (RIP)
which is either on the same machine or a remote computer.
Once the data has been fully read and processed it is sent as
an integrated pixel map (raster) file to print in one smooth
operation. For example, you’ll notice many proofing
printers come supplied with PostScript (Level 3 or later).
Normally a prepared CMYK image is embedded in the
PostScript file of a page layout program and then converted
in the RIP. The RIP takes the PostScript information and
creates the series of dots for each separation to be output to

PostScript printers
There are many desktop PostScript
printers to choose from for less than
$10,000. Which one you should go for
depends on the type of color work you do.
Laser printers are useful to graphic
designers where the low cost of
consumables such as paper and toners is
a major consideration. A setup including a
laser printer and dedicated RIP server is
ideal for low cost proofing and short run
color laser printing. I am thinking here of a
color laser printer such as a Canon copier
or the recent QMS MagiColor 330GX. The
ProofMaster Adesso RIP is a reasonable-
priced software RIP for Mac OS X only.
The ProofMaster Folio is a software RIP
available on all platforms and works on
around 90 types of inkjet printers
(www.proofmaster.net).

Figure 14.5 This shows you how to
customize the color management settings to
simulate a CMYK proof and utilize a custom built
profile for your printer. Under the Show More
Options, select Color Management and select
‘Document’ to print direct from the current
document color space. If you want to simulate a
CMYK proof based on your current Proof Setup
(see Figure 14.4), select ‘Proof Setup’ to use the
current Proof Setup as the source color space.
Select the profile of your inkjet printer as the
Print Space Profile and set the Intent to Relative
Colorimetric or Absolute Colorimetric (see the
explanation in the body text). When you hit the
Print... button repeat the same printing steps as
were used to create the custom print profile.
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film or plate. The Photoshop image data is likely to be in
either TIFF or encapsulated PostScript (EPS) form in the
file created by the page layout program and it is this which
is passed along with the original vector images and fonts to
be rasterized. Printing speed is dependent on the type of
print driver software the printer uses and the amount of
RAM memory installed in the server machine. Too little
memory and either the document will take ages to process
or won’t print at all.

Printing via a RIP
In the studio office where I work, we have a number of
printers. The Epson Stylus Photo1290 for example, is a
reliable machine and I have successfully built profiles for a
number of paper types with this printer. When I acquired
the Epson 7600 Ultrachrome printer, I wanted to print
using a dedicated RIP and decided to go for ImagePrint 5.6
from ColorByte software. The reason for this was that I
wanted to mainly print to glossy roll paper when producing

Figure 14.6 The latest Epson Ultrachrome
printers have proved popular with photographers
who wish to produce enlarged prints or posters.
The Epson 7600 shown here is reasonably priced
but takes up a lot of space in the office.

The paper can be fed into the printer either
from rolls or as single sheets and is as simple to
setup and manage as a normal desktop printer.
This particular machine is connected to a print
server Macintosh computer running the
ImagePrint 5.6 by ColorByte Software. The
ImagePrint interface is shown in Figure 14.7.

Figure 14.7 This is a screen shot of the
ImagePrint 5.5 interface. ImagePrint is a visual
RIP – you setup the page size and position the
image to printed on the page, When you select
the paper type profile in the Color Management
dialog, the document window will display a color
managed preview of what the printed output will
look like.

Client: Errol Douglas. Model: Vicky Kiernon @ Take Two
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posters for clients, but I also wanted to print on a variety of
art paper types. ImagePrint is a visual RIP, which means it
displays how the document will print the same as when in
Photoshop, you use the Custom proof setup to create an
adjusted preview on the screen. The Epson Ultrachrome
printers are very consistent in output quality. So the paper
profiles that are part of the software package, will work on
any machine. The RIP software is being used as a
replacement for the printer driver used by Photoshop. The
software RIP is therefore directly communicating with the
printer hardware, which means that the RIP software
engineers are not constrained by what might be considered
as limitations of the manufacturer’s print driver defaults.
For example, the ImagePrint program has its own way of
controlling the inkjet printer heads to produce subtle tonal
coloring in black and white prints


